
 Walla Walla 
Gun Club
COMPLETE 2015
SHOOT PROGRAM
• R e g i s t e r e d  ATA S h o o t •

• 4 t h  S U N D AY N o n - R e g .  F u n s h o o t s •
• Tu r k e y  a n d  B a c o n  S h o o t s •
• N E W !  S a u s a g e  S h o o t s •

T h i s  B o o k  C o v e r s  A l l  S h o o t s 
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Some images herein marked, and this entire booklet are ©2015 Robert O. Bloch. All rights reserved.

(PLEASE SAVE THIS BOOK ALL YEAR FOR REFERENCE)

WWGC On-Line Program
2015

Notes:
1) This program is the same as the mailed version, except that 
quite a few ads have hyperlinks which will allow you to click on 
them and go directly to their respective websites. How cool is 
that?

2) You will notice that the pages in this booklet seem out of 
order. That’s because they are set up to print out into a booklet, 
with pages that stack one on top of another. 

3) If you want to print this program so that it looks like the 
mailed version, do the following:
	 a) click File>Print or <ctrl>p, and open up your print set-
up page.
	 b) select to print pages 1-9, and then click on the tab or 
the drop-down box that says “Odd Pages Only.”
	 c) click Print
	 d) when pages are printed, DO NOT re-order the pages. 
Instead, turn the whole stack of pages over just as they are, 
replace them into the paper tray. Be sure that the top of the 
printed pages are on the left side of the tray or paper cassette 
(for most printers, some may differ).
	 e) click File>Print or <ctrl>p, and open up your print set-
up page.
	 f)select to print pages 2-10, and then click on the tab or 
the drop-down box that says “Even Pages Only.”
	 g) check the box that says “Reverse Order.”
	 c) click Print
You should have a stack of pages that you can fold, staple, and 
take with you.
 



CABELAS.COM  |  1.800.237.4444

IT’S IN YOUR NATURE.TM 

Let’s face it, shooting isn’t just 
something you do. It’s who you 
are. At Cabela’s, we feel the same 
way. That’s why it’s in our nature 
to support you with thousands 
of experts, more than 50 years of 
experience and every last bit of 
expertise, so you can treasure this 
passion for the rest of your days.
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Harlan Campbell Jr.
17 Time ATA All-American
Member of ATA Hall of Fame

IT’S IN YOUR

TRUTH.
MOMENT OF

22230_wallawallagunclub.indd   1 12/27/13   9:49 AM

Good Luck Shooters!
www.LesSchwab.com

TIRES
CUSTOM WHEELS
BATTERIES
BRAKES
SHOCKS
ALIGNMENT
SUSPENSIONS

COLLEGE PLACE
1735 SW Meadowbrook Blvd.

509-525-9835

WALLA WALLA
2150 E Isaacs Ave.

509-529-2423

MILTON-FREEWATER 
609 E Broadway Ave.

541-938-5507 CLICK HERE
CLICK HERE
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http://www.lesschwab.com/
http://www.cabelas.com/


INSURANCE

Luttrell’s
A U T O  C E N T E R

Doug Luttrell Jim Denoyer
927 W. Rose St. • Walla Walla WA 99362

509•529•7491 • FAX 509•529•1097
www.luttrellsauto.com

• 2015 Schedule • 
•MARCH 15—Smoked Bacon Shoot

•MARCH 20-22—CAMAS PRAIRIE HANDICAP

•MARCH 29—100/100/50 ATA RegiSteRed Shoot

•APRIL 19—60 BiRd continental Style Buddy Shoot

•APRIL 25-26— WASCTP youth tRap Shoot Non-Reg.

•MAY 24—money Shoot: 50/50/25 Trap Non-Reg.

•JUNE 13—(Sat) Valley BiRdShot challenge (SuBj to chg)

•JUNE 28—money Shoot: 50/50/25 Continental

• JULY 26—money Shoot: 50/50/25 Trap Non-Reg.

• AUGUST 23—money Shoot: 50/50/25 Continental

• SEPTEMBER 6— Haun’s MeatS Link SauSage Shoot

• OCTOBER 25—Bacon & SauSage Shoot

• NOVEMBER 22—thankSgiVing tuRkey Shoot

• DECEMBER 6—Bulk SauSage Shoot

•DECEMBER 13—telegRaphic cluB Shoot (14 wk) BeginS

Get InformatIon for all these shoots By CallInG 541•969•7913
or on the weB http://wallawallagunclub.com

Note: Pork prizes subject to substitution as market dictates.

Walla Walla 
     Gun Club

                       Welcome To... 
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ALLA WALLA GUN CLUB

1/2/2015

Best of Luck to all of the Shooters!
WALLA WALLA • DAYTON • BURBANK

509-526-4041 • 509-382-2578 • 800-624-1231

www.columbiarea.coop

www.columbiainet.com

Columbia REA

Columbia Energy, LLC

Powering your    nternet

CLICK HERE

CLICK HERE

CLICK HERE
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http://www.luttrellsauto.com/
http://www.wallawallagunclub.com/
http://www.columbiarea.coop


WELCOME BACK TO 
WALLA WALLA GUN CLUB!

Walla Walla Gun Club is 
pleased to welcome you 
back for the 64th year of 

ATA registered shooting at our 
present location. 

This booklet contains all of our 
registered and non-registered 
shoot programs for 2015. Please 
keep this book in your gun case, 
or close by to refer to often as the 
shooting season progresses. We 
hope to see you plenty during 2015.

Walla Walla Gun Club will host a number of non-registered 
money shoots, both conventional and continental trap 
formats. If you like regular “ATA-Style” trap, look on page 
10 for our Sunday shoots. If you like “continental style” 
shooting, look on page 11 for our Sunday Continental 
shoots. And if you like “meat shoots,” you can find them all 
on page 13. All of Walla Walla’s shoots and other activities 
are posted on our website, http://wallawallagunclub.com. 
Come have a look around!

Call my cellphone directly (see below) if I can help in any 
way.  See you here!

BOB BLOCH, Secretary-Treasurer
Walla Walla Gun Club 

541-969-7913 (cell)
bbloch@bmi.net

Registration Certificate
This certifies that WALLA WALLA GUN CLUB is 
authorized to hold ATA Registered Shoots March 
20-22 and March 29, 2015. All ATA rules will 
govern these shoots and WALLA WALLA GUN 
CLUB will comply with all ATA regulations.
         —Amateur Trapshooting Association, Vandalia, OH 

The 123 Pawn Shop Inc.          1500 E. Isaacs • 509-529-7296

Biggest Selection 
of firearms 
in town!

Discounts
On Firearms
To WWGC
Members!

“Just Ask For Lee”

WHITE FLYER 
PITCH TARGETS

WILL BE THROWN
AT ALL EVENTS AT

WALLA WALLA GUN CLUB
IN 2015

Gas       Diesel       Propane 
Convenience Store 

Car Wash    RV Dump 
Open 24 Hours 

 

Gas • Diesel
Propane

Car Wash•RV Dump
Open 24 Hrs.

ON THE CORNER OF 9TH & ROSE
509•527•0611

EMAIL BOB

CLICK HERE
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mailto:info%40wallawallagunclub.com?subject=2013%20WWGC%20PROGRAM%20INQUIRY
mailto:leezimmerman76%40gmail.com?subject=Inquiry%20From%20WW%20Gun%20Club%20Program%20Ad%202015


509•525•9143
www.koncreteindustries.com

> Premix Concrete > Sealers, Grout > Concrete Tools > Masonry Supplies
> Decorative Rock > Sand & Gravel > Stepping Stones > Drain Rock
> Pea Gravel > A/C Pads  > Fiber Reinforcement > Septic Tanks
> Recycled Concrete     > Bagged Cement

PO Box 911 • 502 N. 13th • Walla Walla WA 99362

JOIN WW GUN CLUB!
 Walla Walla Gun Club wants you to be a part of our 
organization. Membership is $50 per year for adults, 
$25 per year for students, and $75 per year for the 
entire family. Email or call for information:

info@wallawallagunclub.com / 541-969-7913

• Mark, Anthony & Nick Brown •

New  York  StoreSince
1904

Western Outfitters Inc.

Western Wear & Work Clothes For The Whole Family
Boots For Everyone & All Needs

Open Monday—Saturday 9:00-7:00, Sunday 10:30-5:00
2254 E. Isaacs • Walla Walla WA • 509-529-3600

Out Of Water?

We Fix Wells & Pumps!

LES’S PUMP & ELECTRICAL, INC.
509-529-0550 (office)

509-520-3632 (cell)

MARK JUNGMANN
Certified Well Driller

Oregon & Washington

Sales • Installation • Repair
Any Make Or Model

-16- -5-



NOTICE
Walla Walla Gun Club requests that shooters wishing to retain their 
empty shells are encouraged to do so provided that shells are caught 
prior to hitting the ground. Please do not disrupt the shoot or other 
shooters by picking up empty shells.  Thank You!

TROPHY LIST
Sunday, March 29, 2015

Event No. 1
100 ATA SINGLES TARGETS

Event Champion
Winner each class AA, A, B, C, D

Ladies, Vets, Sr. Vets, Jr., and Sub-Junior winner trophies 
will be awarded if class contains 5 or more shooters.

Events No. 2
100 ATA HANDICAP TARGETS 

Winner, Runner-Up
Three Yardage Classes
19-22, 22.5-24.5, 25-27

WSTA Silver Buckle To Champion

Event No. 3
50 PAIR ATA DOUBLES TARGETS

Event Champion
Winner each class A, B, C, D

Ladies, Vets, Sr. Vets, Jr., and Sub-Junior winner trophies 
will be awarded if class contains 5 or more shooters.

MILTON-FREEWATER • STATELINE
85342 HIGHWAY 11 • (541) 938-4200

MON-SAT 7-7 • SUN 9-6
845 N. Columbia Center Blvd. • Kennewick, WA • (509) 737-1996

LLOOOOKKIINNGG  FFOORR  AADDVVEENNTTUURREE??

NNooww  OOppeenn  IInn  MMiillttoonn--FFrreeeewwaatteerr
TToo  SSeerrvvee  YYoouu!!

AAWWEESSOOMMEE  SSTTAAFFFF!!  
AAWWEESSOOMMEE  SSEELLEECCTTIIOONN!!!!

Visit us online at www.Ranch-Home.com

Jus t  Ove r  The  S ta t e  L i ne !

MON-SAT 8-7  •••  SUN 9-6

CLICK HERE

-6- -15-

http://www.ranch-home.com/ShowPage.php?section=Home&page=Online_Shopping


ATA Registered Trapshoot
• Sunday,  March 29, 2015 • 

Squadding & Practice-8:00 am /  Shoot-9:00 am
ATA Daily Fee $3.00 Applies

•1-2-3 PAWN SHOP •
Event No. 1 - 100 16 Yd. Targets

Targets, Trophies....................................................$28.50
WSTA Fee .................................................................$   1.50
Non-Compulsory Purse (1 pay per 5).............. $ 10.00
Lewis Purses (3 Classes, 60/40)........................... $   5.00
..

•LES SCHWAB TIRES OF WW •
WSTA Silver Buckle Event

Event No. 2 - 100 Handicap Targets
Targets, Trophies...................................................$28.50
WSTA Fee ................................................................ $  1.50
Non-Compulsory Purse (1 pay per 5)............. $10.00
Lewis Purses (3 Classes, 60/40).......................... $10.00

•RANCH & HOME OF MF •
Event No. 3 - 50 Pair Doubles Targets
Targets, Trophies...................................................$28.50
WSTA Fee .................................................................$  1.50
Non-Compulsory Purse (1 pay per 5)..............$  5.00
Lewis Purses (3 Classes, 60/40).......................... $  5.00

• HOMECOOKIN’ LUNCH •
For All Shooters & Their Families

• RV Reservations–$15 Call 541-969-7913 •
• PITA CROSS REGISTRATION OFFERED •

WW GUN CLUB & AREA REGISTERED
& FUNSHOOTS FOR 2015

(F) = FUNSHOOT, (T) = TURKEY SHOOT, ($) MONEY SHOOT

Feb   7: Spokane
     15: Grangeville (F)
     21: Colton
Mar  7: Orofino-Pierce
     14-15: Spokane
     15: Walla Walla (Bacon) 
     20-22: Camas Prairie-WW      
     28: Malden-Pine City Youth
     29: Walla Walla ATA
Apr    4: Marlin
     11-12: Spokane NW Grand
     19: Moses Lake
     19: WW Cont’l. Buddy ($)          	
     19: Garfield
     25: Odessa
     25-26: WW WASCTP Youth 
     25-26: Grangeville
May   2: Almira
     2-3: Culdesac
       3: Endicott

     14-17: Spokane Inland Empr.
     22-25: IDAHO STATE SHOOT
     23-24: Republic 
       24: Walla Walla ($,F)
     29-31: OSTA STATE, LaGrande
       31: Ft. Colville
June 6-7: Colton
     13-14: Othello
     20-21: Nezperce
     25-28: WSTA STATE, Spokane
      28: WW Cont’l. ($,F)
July  4: Malden-Pine City (F)
     4-5: Troy-Deary
     11: Endicott (F)
     16-19: Spokane Western Zone
     26: Malden-Pine City
     26: Walla Walla ($,F)
Aug 15-16: Spokane
     22-23: Grangeville
     23: WW Cont’l. ($,F)

Sept  4-6: Spokane PITA
      6: Walla Walla (Sausage)
     12: Lewiston (at Culdesac)
     12: Endicott (F)
     19: Colton
     26-27: Indian Valley
Oct 3-4: Troy-Deary
     18: Spokane
     25: Malden-Pine City (F)
     25: Walla Walla (Bac/Saus)
Nov  7: Spokane
     15: Troy-Deary (T)
     22: Endicott (T)
     22: Walla Walla (T)
     22: Culdesac (T)
     28: Colton (T)
Dec  6: Cottonwood (T)
       6: Walla Walla (Bac/Saus)
      13: Pomeroy (T) 

Note: Dates above are accurate at press time, but may change. Check before you travel.

-7--14-



Shoot Notes
Governing All Shoots 

1.	 ATA RULES govern registered shoots at all times. Walla 
Walla Gun Club rules govern all other shoots & events.

2.	 All contestants, scorers, target setters, referees, and 
anyone else on the firing line must wear eye and ear 
protection at all times. No exceptions.

3.	 No option money will be refunded after event has 
begun. 

4.	 JUNIORS & SUB-JUNIORS may opt out of compulsory 
purses for any Non-Registered Money Shoot (pp 10-11). 

5.	 Unless stated here otherwise, all ties for purses and 
option money divide, and all ties for trophies will be 
settled by shoot-off. Please be aware that anyone not 
answering the call for shoot-off within a 10-minute 
period will forfeit their shoot-off opportunity.

6.	 Targets are thrown from automatic machines only. 
Machines will be set by shoot committee before 
shooting starts each day, and will not be reset unless 
conditions change or equipment fails such that targets 
are illegal. No one except tournament committee 
members may touch traps once they are set. No 
exceptions.

7.	 Walla Walla Gun Club reserves the right to remove and/
or disqualify anyone who interferes with the conduct of 
our shoots, with forfeiture of entry and purse money. 
This includes anyone who is abusive to trap or Gun 
Club officials, or anyone exhibiting unsportsmanlike 
conduct. 

8.	 Management reserves the right to modify this program 
wholly or in part at any time right up until events begin. 
All fees posted in this booklet are accurate at press 
time, but are subject to change.

9.	 It is the shooter’s responsibility to shoot his/her 
correct class and yardage. Any yardage punches and/or 
class advances from a previous day’s shooting must be 
declared and observed prior to event or shooter will 
forfeit entry and purse money.

Turkey & Meat 
Fun Shoots–2015

• Sunday, March 15, 2015 • 
SMOKED BACON SHOOT

$30 SHOOT CARD
6 SHOOTS—Guaranteed Win

• Sunday, September 6, 2015 • 
HAUN’S MEATS SAUSAGE SHOOT

$30 SHOOT CARD
6 SHOOTS—Guaranteed Win

• Sunday, October 25, 2015 • 
BACON & BULK SAUSAGE SHOOT

$30 SHOOT CARD
6 SHOOTS—Guaranteed Win

• Sunday, November 22, 2015 •
PRE-THANKSGIVING 

TURKEY SHOOT
$35 SHOOT CARD

6 SHOOTS—Guaranteed Win

• Sunday, December 6, 2015 •
 HOLIDAY SAUSAGE—NEW!

$30 SHOOT CARD
6 SHOOTS—Guaranteed Win

-13--8-



To date, Walla Walla Gun Club has collected over $20,000.00 to be 
used toward our new range project. If you have scrap metal to donate, or 
would like to contribute money or saleable valuables, please contact us.

Please note that all contributions are fully tax deductible on your form 
1040 US Tax Return. 

BIG!Scrap Metal Drive

WALLA WALLA
GUN CLUB

Announcing Our Big Fund Raising Project 
To Build Our New Range
Won’t You Please Help?

•	 Old	Automobiles	or	Parts
•	 Pots	&	Pans	No	Longer	Used
•	 Farm	Machinery
•	 Anything	Metal
•	 Large	or	Small

Will	Pick	Up	–	Any	Size	–	Any	Quantity
All	Donations	Tax	Deductible	On	Federal	Income	Tax

Call	509-529-7288	or	visit
http://wallawallagunclub.org

Call 541-969-7913
info@wallawallagunclub.com

SCTP /   USAYESS 
YOUTH SHOOT

S a t u r d a y  &  S u n d a y
A P R I L  2 5 - 2 6 ,  2 0 1 5
8:00 am Sign-Up & Practice, 9:00 am Start

All Targets Non-Registered • LUNCH AVAILABLE

•Saturday: 100 Skeet Targets•
•Sunday: 50 Trap Singles Targets•

•Sunday: 25 pr. Trap Doubles Targets•
$70 Entry For All 200 Targets

Shoot Is Open To All Groups And Individuals Regardless  Of Age  Or Affiliation

14 TROPHIES & PRIZES
• High School Team (full squad gr 9-12) •

Champion–1 Flat 12 ga Target Loads 

• Middle School Team (full squad gr 6-8) •
Champion–1 Flat 12 ga Target Loads

 • Individual •
High School Skeet Winner, Runner-Up

Middle School Skeet Winner, Runner-Up
High School 16-yd Winner, Runner-Up

Middle School 16-yd Winner, Runner-Up
High School Doubles Winner, Runner-up

Middle School Doubles Winner, Runner-Up
Each Winner or Champion–4 boxes 12 ga Target Loads

Each Runner-Up–2 boxes 12 ga Target Loads

-9--12-



• ATA-Style Trap Money Shoots •
(Non-Registered)

• Continental Trap Money Shoots •
(Non-Registered)

Sunday,  APRIL 19, 2015
     60 BIRD CONTINENTAL BUDDY* SHOOT

		  Targets ..............................................$25.00
		  Compulsory Purse .........................$15.00
		    (Non-Compulsory for Juniors & Sub-Juniors)
	       Non-Registered. One Lewis Class per Seven Entries

Divided 60/40 Each Class
*Draw-Buddy • Ties Divide

Sunday,  JUNE 28, 2015
-and-

Sunday,  AUGUST 23, 2015

Event 1: 50 CONTINENTAL SINGLES (18 yd)
		  Targets .................................................$15.00
		  Compulsory Purse ............................$  5.00

       (Non-Compulsory for Juniors & Sub-Juniors)
		  **Option (Events 1,2, & 3) ..............$  5.00

 Non-Registered. One Lewis Class per Seven Entries
Divided 60/40 Each Class • Ties Divide

Event 2: 50 CONTINENTAL HANDICAP (24 yd)
		  Targets .................................................$15.00
		  Compulsory Purse ............................$  5.00

       (Non-Compulsory for Juniors & Sub-Juniors)
Non-Registered. One Lewis Class per Seven Entries

Divided 60/40 Each Class • Ties Divide

Event 3: 25 Pair CONTINENTAL DOUBLES (16 yd)
		  Targets .................................................$15.00
		  Compulsory Purse ............................$  5.00

       (Non-Compulsory for Juniors & Sub-Juniors)
Non-Registered. One Lewis Class per Seven Entries

Divided 60/40 Each Class • Ties Divide

Fourth SUNDAY: CONTINENTAL-STYLE TRAP SHOOTS

Sunday,  MAY 24, 2015
-and-

Sunday,  JULY 26, 2015

Event 1: 50 ATA-Style 16 YARD Targets
	      Targets .................................................$15.00
	       Compulsory Purse ...........................$  5.00

       (Non-Compulsory for Juniors & Sub-Juniors)
	      **Option (Events 1,2, & 3) ...............$  5.00

 Non-Registered. One Lewis Class per Seven Entries
Divided 60/40 Each Class • Ties Divide

Event 2: 50 ATA-Style HANDICAP Targets
	       Targets ................................................$15.00
	        Compulsory Purse ...........................$  5.00

       (Non-Compulsory for Juniors & Sub-Juniors)
Non-Registered. One Lewis Class per Seven Entries

Divided 60/40 Each Class • Ties Divide

Event 3: 25 Pair ATA-Style DOUBLES
		  Targets .........................................$15.00
		  Compulsory Purse ....................$  5.00

       (Non-Compulsory for Juniors & Sub-juniors)
Non-Registered. One Lewis Class per Seven Entries

Divided 60/40 Each Class • Ties Divide

SHOOT NOTES FOR PAGES 10 & 11
• There are three separate events each day, 16 yd, 	
	 handicap, and doubles (except April 19).
•  Shooters may shoot any or all events each day.
•  **The $5.00 Option purse shown in Event 1 each 	
	 day is for Events 1,2, and 3 total score.
•  Lewis Classes ensure that everybody has a good 	
	 chance to win, regardless of ability.

Fourth SUNDAY: ATA-STYLE TRAP SHOOTS

-10- -11-


